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1 Avant-propos
Le module de sécurité SY6 ajoute aux servo-variateurs STOBER de la gamme SC6 ou SI6 les fonctions de sécurité Safe
Torque Off (STO) et Safe Stop 1 (SS1), toutes deux décrites dans la norme DIN EN 61800-5-2.

Dans un servo-variateur, la fonction STO empêche, immédiatement après son activation, la génération d’un champ
tournant électrique indispensable au fonctionnement des moteurs synchrones et asynchrones. Dans le cas de la fonction
SS1-t, la coupure a lieu après une durée configurable.

Les fonctions de sécurité STO et SS1 sont commandées via EtherCAT (FSoE) dans le cas de la combinaison servo-variateur et
module de sécurité SY6.

En tant que solution entièrement électronique, SY6 se distingue par un fonctionnement rapide et sans usure. Le module de
sécurité est conçu de telle manière que les tests du système, qui interrompaient régulièrement la production,
appartiennent désormais au passé. Dans la pratique, cela se traduit par une disponibilité accrue des machines et des
installations. De plus, la planification et la documentation, bien souvent très complexes, des essais de fonctionnement
deviennent superflues.

Les servo-variateurs avec module de sécurité intégré peuvent être utilisés dans les systèmes complexes du point de vue de
la technique de sécurité jusqu’à SIL 3, PL e, catégorie 4. La conformité avec les exigences normatives a été contrôlée par un
organisme de contrôle indépendant dans le cadre d'un examen de type.

Les servo-variateurs des gammes SC6 et SI6 ont réussi aux tests de conformité EtherCAT et Fail Safe over EtherCAT (FSoE)
au cours desquels l'interface de communication a été testée dans le but de garantir la fiabilité et la fonctionnalité,
indépendamment du fabricant, de la communication sous-jacente.
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2 Informations utilisateur
La présente documentation contient toutes les informations relatives à l’utilisation conforme à l'emploi prévu du servo-
variateur en combinaison avec le module de sécurité SY6.

2.1 Conservation et remise à des tiers
Comme la présente documentation contient des informations importantes à propos de la manipulation efficiente et en
toute sécurité du produit, conservez-la impérativement, jusqu’à la mise au rebut du produit, à proximité directe du produit
en veillant à ce que le personnel qualifié puisse la consulter à tout moment.

En cas de remise ou de vente du produit à un tiers, n’oubliez pas de lui remettre la présente documentation.

2.2 Produit décrit
La présente documentation est obligatoire pour :

les servo-variateurs de la gamme SC6 ou SI6 en combinaison avec le module de sécurité SY6 et le logiciel DriveControlSuite
(DS6) à partir de V 6.4-E et le micrologiciel correspondant à partir de V 6.4-E.

2.3 Actualité
Vérifiez si le présent document est bien la version actuelle de la documentation. Vous pouvez télécharger les versions les
plus récentes de documents relatives à nos produits sur notre site Web : 
http://www.stoeber.de/fr/download.

2.4 Langue originale
La langue originale de la présente documentation est l’allemand ; toutes les versions en langues étrangères ont été
traduites à partir de la langue originale.

2.5 Limitation de responsabilité
La présente documentation a été rédigée en observant les normes et prescriptions en vigueur et reflète l’état actuel de la
technique.

STOBER décline toute responsabilité pour les dommages résultant de la non-observation de la documentation ou d’une
utilisation non conforme du produit. Cela vaut en particulier pour les dommages résultant de modifications techniques
individuelles du produit ou de sa planification et de son utilisation par un personnel non qualifié.

http://www.stoeber.de/fr/download
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2.6 Conventions de représentation
Afin que vous puissiez rapidement identifier les informations particulières dans la présente documentation, ces
informations sont mises en surbrillance par des points de repère tels que les mentions d’avertissement, symboles et
balisages.

2.6.1 Utilisation de symboles
Les consignes de sécurité sont accompagnées des symboles ci-dessous. Elles attirent l’attention sur les dangers particuliers
liés à l’utilisation du produit et sont accompagnées de mots d’avertissement correspondants qui indiquent l’ampleur du
danger. Par ailleurs, les conseils pratiques et recommandations en vue d’un fonctionnement efficient et irréprochable sont
également mis en surbrillance.

ATTENTION !

Attention

signifie qu’un dommage matériel peut survenir

▪ lorsque les mesures de précaution mentionnées ne sont pas prises.

PRUDENCE !

Prudence

La présence d’un triangle de signalisation indique l’éventualité de légères blessures corporelles

▪ lorsque les mesures de précaution mentionnées ne sont pas prises.

AVERTISSEMENT !

Avertissement

La présence d’un triangle de signalisation indique l’éventualité d’un grave danger de mort

▪ lorsque les mesures de précaution mentionnées ne sont pas prises.

DANGER !

Danger

La présence d’un triangle de signalisation indique l’existence d’un grave danger de mort

▪ lorsque les mesures de précaution mentionnées ne sont pas prises.

Information

La mention Information accompagne les informations importantes à propos du produit ou la mise en surbrillance d’une
partie de la documentation, qui nécessite une attention toute particulière.
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2.6.2 Conventions typographiques
Certains éléments du texte courant sont représentés de la manière suivante.

Information importante Mots ou expressions d'une importance particulière

Interpolated position mode En option : nom de fichier, nom de produit ou autres noms

Informations complémentaires Renvoi interne

http://www.musterlink.de Renvoi externe

Affichages logiciels et écran

Les représentations suivantes sont utilisées pour identifier les différents contenus informatifs des éléments de l'interface
utilisateur logicielle ou de l'écran d'un servo-variateur ainsi que les éventuelles saisies utilisateur.

Menu principal 
Réglages

Noms de fenêtres, de boîtes de dialogue et de pages ou boutons cités
par l'interface utilisateur, noms propres composés, fonctions

Sélectionnez 
Méthode de référençage A

Entrée prédéfinie

Mémorisez votre 
<Adresse IP propre>

Entrée personnalisée

ÉVÉNEMENT 52 : 
COMMUNICATION

Affichages à l'écran (état, messages, avertissements, dérangements),
informations relatives à l'état citées par l'interface utilisateur

Les raccourcis clavier et les séquences d'ordres ou les chemins d'accès sont représentés comme suit.

[CTRL], [CTRL] + [S] Touche, raccourci clavier

Tableau > Insérer tableau Navigation vers les menus/sous-menus (entrée du chemin d'accès)

Mode de lecture identifiant de paramètre

Un identifiant de paramètre est composé des éléments suivants, les formes abrégées, c.-à-d. uniquement la saisie d’une
coordonnée ou la combinaison d’une coordonnée et d’un nom, étant possibles.

E50 V0

Coordonnées Nom Version

Servo-variateur

2.6.3 Mathématiques et formules
Pour l'affichage de relations et formules mathématiques, les caractères suivants sont utilisés.

- Soustraction

+ Addition

× Multiplication

÷ Division

| | Montant

http://www.stoeber.de
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2.7 Marques
Les noms suivants utilisés en association avec l’appareil, ses options et ses accessoires, sont des marques ou des marques
déposées d’autres entreprises :

EtherCAT®,
Safety over EtherCAT®,
TwinCAT®

EtherCAT®, Safety over EtherCAT® et TwinCAT® sont des marques déposées et des
technologies brevetées qui sont commercialisées sous licence par la société
Beckhoff Automation GmbH, Verl, Allemagne.

Toutes les autres marques qui ne sont pas citées ici sont la propriété de leurs propriétaires respectifs.

Les produits enregistrés comme marques déposées ne sont pas identifiés de manière spécifique dans la présente
documentation. Il convient de respecter les droits de propriété existants (brevets, marques déposées, modèles déposés).
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3 Consignes de sécurité générales
Le produit décrit dans la présente documentation est source de dangers éventuels qui peuvent être toutefois évités à
condition de respecter les messages d’avertissement et consignes de sécurité mentionnés, ainsi que les règlements et
prescriptions techniques.

3.1 Normes
Les normes européennes suivantes s’appliquent au produit spécifié dans la présente documentation :

§ DIN EN ISO 13849-1:2016

§ DIN EN ISO 13849-2:2013

§ DIN EN 61800-5-2:2017-11

§ DIN EN 61508-x:2011

§ DIN EN 60204-1:2007

§ DIN EN 62061:2016

§ CEI 61784-3:2010

Pour une meilleure lisibilité, nous ne précisons pas l'année respective des renvois aux normes ci-après.

3.2 Personnel qualifié
Dans le cadre de l’exécution des tâches expliquées dans la présente documentation, les personnes chargées de ces tâches
doivent disposer des qualifications professionnelles inhérentes et être en mesure d’évaluer les risques et dangers résiduels
liés à la manipulation des produits. C’est la raison pour laquelle tous les travaux sur les produits, ainsi que leur utilisation et
leur élimination, sont strictement réservés à un personnel qualifié.

Par personnel qualifié on entend les personnes dûment autorisées à exécuter les tâches mentionnées, soit par une
formation de technicien, soit après avoir suivi une initiation dispensée par des personnes qualifiées.

Par ailleurs, il incombe de lire attentivement, comprendre et respecter les dispositions en vigueur, les prescriptions légales,
les règlements applicables, la présente documentation ainsi que les consignes de sécurité inhérentes.
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3.3 Utilisation conforme
Le module de sécurité SY6 peut être combiné avec les servo-variateurs STOBER de la gamme SC6 ou SI6.

En cas d’utilisation d’un servo-variateur avec le module de sécurité intégré SY6 au sein d’une application liée à la sécurité, le
module de sécurité doit impérativement être contrôlé par un relais de sécurité ou une commande de sécurité.

DANGER !

Tension électrique ! Danger de mort par électrocution !

L’activation de la fonction de sécurité STO implique simplement une génération intermittente de champ tournant sur le
moteur. De hautes tensions dangereuses peuvent toujours encore traverser le moteur.

▪ Veillez à ne pas toucher les pièces sous tension.

▪ Lorsqu’il s’avère nécessaire de couper la tension d’alimentation, observez les exigences de la norme DIN EN 60204-1.

Utilisation non conforme à l'usage prévu

Il est interdit d'utiliser le module de sécurité en dehors du servo-variateur ou des spécifications techniques applicables.

Information

Le module de sécurité SY6 ne permet pas de réaliser un arrêt d’urgence contrôlé selon DIN EN 60204-1 ! 
Veuillez observer cette norme pour la différenciation entre Arrêt d’urgence contrôlé et Arrêt d’urgence en liaison avec 
Safe Torque Off.

Modification

En votre qualité d'utilisateur, il vous est interdit de modifier la construction et les caractéristiques techniques ou électriques
du module de sécurité SY6. Il est interdit de retirer le module du servo-variateur, de le réparer ou de le remplacer soi-
même.

Maintenance

Le module de sécurité est sans entretien.

Durée de vie du produit

Un servo-variateur avec module de sécurité intégré doit être mis hors service 20 ans après la date de production. La date de
production d'un servo-variateur est indiquée sur la plaque signalétique correspondante.

3.4 Mise hors service
Dans le cas d'applications de sécurité, notez le temps de mission TM = 20 ans dans les caractéristiques techniques relatives à
la sécurité.
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4 Module de sécurité SY6
Le module de sécurité SY6 ajoute les fonctions de sécurité STO (Safe Torque Off) et SS1 (Safe Stop 1) au servo-variateur. 
Le module empêche la formation d'un champ tournant dans le bloc de puissance du servo-variateur et fait passer
immédiatement ou de manière temporisée (SS1-t) le servo-variateur à l'état STO en présence d'une erreur ou sur requête
externe.

Caractéristiques

§ Fonctions de sécurité réalisables :

• Couple déconnecté en toute sécurité – STO selon DIN EN 61800-5-2

• Catégorie d’arrêt 0 selon DIN EN 60204-1

• Arrêt sûr 1 (temporisé) – SS1-t conformément à DIN EN 61800-5-2

• Catégorie d’arrêt 1 selon DIN EN 60204-1

§ Commande des fonctions de sécurité via Safety over EtherCAT (FSoE)

§ Temps de coupure STO : < 50 ms

§ Sans usure

Certifications conformément à DIN EN 61800-5-2 et DIN EN ISO 13849-1

§ Safety Integrity Level  (SIL) 3

§ Performance Level  (PL) e

§ Catégorie 4
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5 Structure du système et principe de
fonctionnement
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Fig. 1: Composants du concept de sécurité basé sur FSoE

Composants du système

Les principaux composants de ce concept de sécurité basé sur FSoE sont :

§ Servo-variateurs avec module de sécurité intégré SY6
... pour la réalisation des fonctions de sécurité STO et SS1-t

§ Commande (API) avec Maître EtherCAT intégré
-... pour l'organisation de l'ensemble de la communication réseau

§ Coupleur de bus (coupleur EtherCAT)
... comme lien entre la commande et la commande de sécurité ; le coupleur de bus transmet les télégrammes de la
commande de sécurité au Maître EtherCAT

§ Commande de sécurité (S-API) avec Maître FSoE intégré
... pour la communication FSoE ainsi que la liaison logique des participants FSoE ; la commande de sécurité comporte
des modules de sécurité certifiés qui peuvent être configurés en fonction de l'application à l'aide d'un logiciel
d'automatisation approprié

§ Terminaux de sécurité avec entrées et sorties numériques à sécurité intégrée
... pour le raccordement de capteurs de sécurité 24 VCC comme par exemple les interrupteurs d'arrêt d'urgence ou de
position, les barrages photoélectriques, tapis de contact etc.

§ Protocole FSoE
... pour la transmission des données de sécurité

§ EtherCAT
... comme système de bus de terrain sous-jacent
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Principe de fonctionnement

La pièce de commande du servo-variateur génère un modèle d’impulsions (MLI) en vue de la génération d'un champ
tournant sur le module IGBT du bloc de puissance. Ce champ tournant est nécessaire au fonctionnement de moteurs
synchrones et asynchrones.

Lorsque la fonction de sécurité est désactivée, le module de sécurité SY6 active la génération du champ tournant dans le
bloc de puissance ; le moteur raccordé peut générer un champ tournant. Lorsque la fonction de sécurité est active, SY6
bloque la génération du champ tournant dans le bloc de puissance et le servo-variateur ne parvient pas à générer un couple
dans le moteur raccordé.

Le module de sécurité SY6 implémente un Esclave FSoE. Ce dernier échange les informations de commande et d'état avec le
Maître FSoE via le Maître EtherCAT conformément au principe Black-Channel. L'Esclave décompresse les données de
sécurité, les plausibilise et autorise / bloque les deux canaux de sécurité dans le bloc de puissance.

Les fonctions de sécurité STO et SS1-t se rapportent à l'appareil et ne sont pas spécifiques aux axes. Dans le cas de
régulateurs double axe, les deux axes sont simultanément mis dans l'état sûr. 
Un SS1 activé ne peut pas être annulé.

AVERTISSEMENT !

Surcourse prolongée ! Mouvement résiduel !

Le module de sécurité ne peut pas empêcher une défaillance de la partie fonctionnelle du servo-variateur (p. ex. en cas de
mise à l'arrêt commandée) pendant l'exécution de la fonction de sécurité SS1-t. D'où l'impossibilité d'utiliser SS1-t lorsque
cette défaillance est susceptible de provoquer une situation dangereuse dans l'application finale. Tenez compte de ce fait
lors de la planification.

En cas d'erreur dans le bloc de puissance du servo-variateur – bien que la fonction STO soit active – un passage de courant
statique est possible dans le moteur, l'arbre du moteur pouvant ici se déplacer, au maximum, de l'angle 360° ÷ (p × 2).
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6 Caractéristiques techniques
Les conditions de transport, de stockage et de fonctionnement du module de sécurité sont indiquées dans les
caractéristiques techniques du servo-variateur (voir chapitre Informations complémentaires [} 49]).

Le tableau ci-dessous contient les indicateurs pertinents en matière de technique de sécurité pour le module SY6.

SIL CL 3

SIL 3

PL e

Catégorie 4

PFHD 5 × 10-9 [1/h]

Temps de mission 20 ans

Temps d’arrêt STO < 50 ms

Temporisation SS1 10 – 655350 ms (± 1 %)

Tab. 1: SY6 – Indicateurs pertinents en matière de sécurité
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7 Bon à savoir avant la mise en service
Les chapitres ci-dessous offrent une entrée en matière rapide dans la structure de l'interface programme ainsi que les
désignations de fenêtre correspondantes et fournit des informations utiles relatives aux modalités générales
d'enregistrement de votre planification.

7.1 Interfaces programme
Les chapitres suivants contiennent les interfaces programme des composants logiciels décrits.

7.1.1 DS6 : structure de l'interface programme
Le logiciel de mise en service DriveControlSuite (DS6) offre une interface graphique vous permettant de planifier,
paramétrer et mettre en service votre modèle d'axe rapidement et efficacement.

1

2

3

4

5 6

Fig. 2: DS6 : interface programme

1 Arborescence de projet

2 Menu de projet

3 Zone de travail

4 Description de paramètre

5 Contrôle des paramètres

6 Messages
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7.1.2 TwinCAT 3 : structure de l'interface programme
Procédez à la mise en service de votre système EtherCAT dans TwinCAT 3 via TwinCAT System Manager. Le graphique ci-
dessous contient les éléments d'interface importants pour la présente documentation.

1

2

3

4

5 6

Fig. 3: TwinCAT 3 (TwinCAT XAE) – Interface programme

1 Solution Explorer

2 Fenêtre principale

3 Affichage Message

4 Toolbox

5 Affichage des événements

6 Affichage d'état (mode Config, Run, établissement de la connexion / Timeout)

7.2 Enregistrement non volatile
Toutes les planifications, tous les paramétrages et les modifications des valeurs de paramètres associées prennent effet
après la transmission au servo-variateur, mais ne sont pas encore sauvegardés dans une mémoire non volatile.

Enregistrez les données à l'aide de la fonction Sauvegarder valeurs dans le paramètre A00 (Menu de projet > Zone
Assistants > Axe planifié > Assistant Sauvegarder valeurs).

C'est le seul moyen de garantir un enregistrement non volatile des données.
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8 Mise en service
Les chapitres suivants traitent de la mise en service de votre servo-variateur et du module de sécurité SY6 à l'aide du
STOBER logiciel DriveControlSuite ainsi que du configurateur TwinSAFE de TwinCAT 3 de la société Beckhoff Automation
GmbH & Co. KG.

Pour un suivi exact des différentes étapes de la mise en service, nous citons en exemple l'environnement système suivant
comme condition préalable :

§ Beckhoff CX2030 – module de base CPU (commande, Maître EtherCAT)

§ Borne TwinSAFE-Logic EL6900 Beckhoff (commande de sécurité, Maître FSoE)

§ Coupleur de bus Beckhoff EK1100 (coupleur de bus EtherCAT)

§ Borne d'entrée numérique à 4 canaux TwinSAFE EL1904 Beckhoff (borne numérique avec 4 entrées à sécurité intégrée)

§ Logiciel d'automatisation TwinCAT 3 Beckhoff : TwinCAT System Manager (configurateur TwinSAFE), TwinCAT XAE

§ Servo-variateurs STOBER de la gamme SC6 ou SI6 avec module de sécurité SY6 intégré

§ STOBER Logiciel de mise en service DriveControlSuite à partir de la version 6.4-D

Information

La mise en service du servo-variateur et du module de sécurité SY6 en combinaison avec le contrôleur de mouvement MC6
STOBER et l'environnement de développement AutomationControlSuite (AS6) STOBER est en préparation.

La mise en service comporte les étapes suivantes ...

1. Module de sécurité SY6
Attribuez une adresse FSoE valide.

2. Observez les recommandations relatives aux réglages de l'heure valables pour la configuration ci-après.

3. DriveControlSuite
Configurez tous les servo-variateurs, y compris les modules de sécurité, commandes de l'appareil et données process
pour la communication par bus de terrain ainsi que les axes de votre système d'entraînement dans DriveControlSuite.
Générez un fichier ESI et transférez ensuite votre configuration de projet vers les servo-variateurs du réseau système
intégré.

4. TwinCAT 
Mettez à disposition le fichier ESI TwinCAT 3 généré. Reproduisez ensuite votre environnement matériel complet et
configurez-le. Mettez ensuite votre système en service et vérifiez la communication TwinSAFE des participants au
système.

8.1 SY6 : attribuer l'adresse FSoE
Afin de pouvoir identifier de manière univoque le module de sécurité SY6 dans le réseau FSoE, vous devez lui attribuer une
adresse univoque dans le réseau FSoE. L'adresse résulte des valences des commutateurs DIP placés sur ON (voir le chapitre
SY6 : attribuer l'adresse FSoE [} 45] pour de plus amples informations à ce sujet).

Information

Notez que le servo-variateur doit être coupé avant l'attribution de l'adresse FSoE via le commutateur DIP. L'adresse n'est
appliquée qu'après un redémarrage du servo-variateur.
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8.2 Réglages de l'heure recommandés
Pour s'assurer qu'en cas d'arrêt rapide suivi de STO (catégorie d'arrêt 1 conformément à DIN EN 60204-1 ou Safe Stop 1
(SS1) conformément à DIN EN 61800 5 2) ou qu'en cas d'interruption de la communication pendant le freinage contrôlé le
bloc de puissance n'est pas mis hors tension et le mouvement de l'axe n'arrête pas d'être contrôlé par le servo-variateur, il
faut tenir compte de la temporisation résultant de l'arrêt rapide (temps d'arrêt rapide) lors du paramétrage de la
temporisation SS1 et du temps du chien de garde FSoE.

Temps d'arrêt rapide

Le temps d'arrêt rapide est calculé à partir de la temporisation d'arrêt rapide spécifique à l'application et de la vitesse
maximale. Pour les applications conformément à CiA 402, paramétrez la temporisation d'arrêt rapide dans A578 Quick stop
deceleration. Paramétrez la vitesse maximale dans I10 Vitesse maximale.

Temporisation SS1

Pour T_SS1 dans le Maître FSoE, définissez une valeur supérieure à celle du temps d'arrêt rapide résultant. En règle
générale, la réserve devrait être de 10 % et ne devrait pas être inférieure à 50 ms. Vous pouvez vérifier la temporisation SS1
dans S593 SS1 temps jusqu'à STO.

Temps du chien de garde FSoE

Pour le temps du chien de garde dans le Maître FSoE, définissez une valeur supérieure à celle du temps d'arrêt rapide
résultant avec la temporisation PDO en sus (A258 EtherCAT PDO-Timeout). En règle générale, la réserve devrait être de
10 % et ne devrait pas être inférieure à 100 ms. Vous pouvez vérifier le temps du chien de garde dans S27 FSoE durée du
chien de garde. Dans le cas de TwinCAT 3, un temps du chien de garde global de 100 ms est réglé par défaut. Pour de plus
amples informations sur le temps du chien de garde, voir chapitre Temps du chien de garde FSoE [} 46].
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8.3 DS6 : configurer le servo-variateur
Planifiez et configurez tous les servo-variateurs de votre système d'entraînement via DriveControlSuite.

8.3.1 Créer un projet
Afin de pouvoir configurer tous les servo-variateurs et axes de votre système d'entraînement à l'aide du DriveControlSuite,
vous devez les saisir dans le cadre d'un projet.

8.3.1.1 Planifier le servo-variateur et l'axe

Créer un nouveau projet

1. Démarrez DriveControlSuite.

2. Cliquez sur Créer un nouveau projet.

ð La fenêtre de planification s'ouvre, le bouton Servo-variateur est actif.

Planifier le servo-variateur

1. Onglet Caractéristiques : 
établissez dans DriveControlSuite la relation entre votre schéma de connexion et le servo-variateur à planifier.
Référence : entrez le code de référence (code d'équipement) du servo-variateur.
Désignation : dénommez le servo-variateur de manière univoque.
Version : attribuez une version à votre planification.
Description : entrez, si nécessaire, des informations complémentaires utiles telles que l'historique des modifications
de la planification.

2. Onglet Servo-variateur : 
sélectionnez la gamme et le type de servo-variateur.

3. Onglet Modules optionnels : 
Module de sécurité : sélectionnez le module SY6.

4. Onglet Commande de l'appareil :
Commande de l'appareil : sélectionnez la commande de l'appareil qui définit les signaux de contrôle fondamentaux du
servo-variateur.
Données process Rx, données process Tx : sélectionnez EtherCAT Rx et EtherCAT Tx pour la transmission des données
process EtherCAT.
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Planifier un axe

1. Cliquez sur Axe 1.

2. Onglet Caractéristiques : 
établissez dans DriveControlSuite la relation entre votre schéma de connexion et l'axe à planifier.
Référence : entrez le code de référence (code d'équipement) de l'axe.
Désignation : dénommez l'axe de manière univoque.
Version : attribuez une version à votre planification.
Description : saisissez, si nécessaire, des informations complémentaires utiles comme l'historique des modifications
de la planification.

3. Onglet Application : 
sélectionnez l'application basée sur la commande souhaitée.
Si vous utilisez les produits matériels et logiciels proposés par la société Beckhoff, nous recommandons CiA 402
(version incrémentielle).

4. Onglet Moteur : 
sélectionnez le type de moteur que vous exploitez au moyen de cet axe. Si vous utilisez des moteurs de fabricants
tiers, entrez les données moteur correspondantes à un moment ultérieur.

5. Répétez les étapes 2 à 4 pour le deuxième axe (seulement dans le cas de régulateurs double axe).

6. Cliquez sur OK pour confirmer.

8.3.2 Paramétrer les réglages EtherCAT généraux

ü Dans le cadre de la planification du servo-variateur et de l'axe, vous avez planifié, entre autres, le module de sécurité
SY6 ainsi qu'une commande de l'appareil avec les données process EtherCAT Rx et EtherCAT Tx.

1. Dans l'arborescence de projet, marquez le servo-variateur correspondant et cliquez dans le menu de projet > Zone
Assistant sur le premier axe planifié.

2. Sélectionnez l'assistant EtherCAT.

3. A213 Mise à l'échelle bus de terrain :
laissez le réglage par défaut sur 1: Valeur brute (les valeurs sont transférées telles quelles).

4. A258 EtherCAT PDO-Timeout :
pour pouvoir détecter une panne de communication, surveillez l'entrée des données process cycliques via la définition
d'une temporisation PDO. 
Plage de valeurs admissible : 0 – 65535 ms. 
Remarque :
0 et 65535 = surveillance inactive 
1 à 65531 = surveillance active 
65532 = surveillance active, toutefois la défaillance d'un paquet de données est ignorée
65533 = surveillance active, toutefois la défaillance conséquente de trois paquets de données est ignorée
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8.3.3 Configurer la transmission PDO
Les canaux PDO servent à la transmission en temps réel des informations de commande et d'état, ainsi que des valeurs
réelles et de consigne d'un Maître EtherCAT vers les Esclaves EtherCAT et vice-versa.

La communication PDO permet le fonctionnement simultané de plusieurs canaux PDO pour chaque sens de transmission et
de réception. Les canaux pour les axes A et B comportent chacun un PDO avec au maximum 24 paramètres à transférer
dans un ordre défini. Ces derniers peuvent être configurés librement. Un canal est réservé pour la communication FSoE et
est automatiquement paramétré.

Afin de garantir une communication impeccable entre la commande et le servo-variateur, STOBER propose une affectation
par défaut, dépendante de l'application des canaux et pouvant être modifiée à tout moment.

8.3.3.1 Personnaliser RxPDO

ü Vous avez configuré les réglages EtherCAT globaux.

1. Dans l'arborescence de projet, marquez le servo-variateur concerné et cliquez dans le menu de projet > Zone Assistant
sur le premier axe planifié.

2. Sélectionnez l'assistant EtherCAT > Données process de réception RxPDO.

3. Vérifiez les réglages par défaut et/ou configurez les données process conformément à vos exigences.
A225[0] – A225[23], A226[0] – A226[23] :
les paramètres dont les valeurs sont reçues par chacun des servo-variateurs depuis la commande. La position des
paramètres fournit des informations sur l'ordre de réception correspondant.

8.3.3.2 Personnaliser TxPDO

ü Vous avez configuré les réglages EtherCAT globaux.

1. Dans l'arborescence de projet, marquez le servo-variateur concerné et cliquez dans le menu de projet > Zone Assistant
sur le premier axe planifié.

2. Sélectionnez l'assistant EtherCAT > Données process d'émission TxPDO.

3. Vérifiez les réglages par défaut et/ou configurez les données process conformément à vos exigences.
A233[0] – A233[23], A234[0] – A234[23] : 
paramètres dont les valeurs sont envoyées par le servo-variateur concerné vers la commande. La position des
paramètres fournit des informations sur l'ordre de transmission correspondant.
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8.3.4 Transférer et enregistrer la configuration
Afin de pouvoir transférer la configuration vers un ou plusieurs servo-variateurs et l'enregistrer, votre ordinateur personnel
doit se trouver dans le même réseau que les appareils concernés.

Transférer la configuration

ü Les servo-variateurs sont opérationnels.

1. Dans l'arborescence, marquez le module sous lequel vous avez saisi votre servo-variateur et cliquez dans le menu
Projet sur Affectation et mise à jour automatique du micrologiciel.

ð La fenêtre Ajouter une liaison s'ouvre. Tous les servo-variateurs détectés via la diffusion IPv4-Limited s'affichent.

2. Onglet Liaison directe > Colonne Adresse IP : 
activez l'adresse IP concernée ou toutes les adresses énumérées via le menu contextuel. Cliquez sur OK pour
confirmer votre sélection.

ð La fenêtre Affectation et mise à jour automatique du micrologiciel s'ouvre. Tous les servo-variateurs connectés via
les adresses IP précédemment sélectionnées s'affichent.

3. Sélectionnez le servo-variateur vers lequel vous souhaitez transférer une configuration. Modifiez la sélection du mode
de transmission de Lire  à Envoyer.

4. Modifiez la sélection Créer un nouveau servo-variateur :
sélectionnez la configuration que vous souhaitez transférer vers le servo-variateur.

5. Répétez les étapes 3 et 4 pour tous les autres servo-variateurs vers lesquels vous souhaitez transférer une
configuration.

6. Onglet En ligne :
cliquez sur Établir des liaisons en ligne.

ð Les configurations sont transférées vers les servo-variateurs.

Information

Lors de la recherche, tous les servo-variateurs à l'intérieur du domaine de diffusion sont localisés via la 
diffusion IPv4-Limited.

Conditions préalables à la recherche d'un servo-variateur dans le réseau :

▪ Le réseau prend en charge la diffusion IPv4-Limited

▪ Tous les servo-variateurs sont dans le même sous-réseau (domaine de diffusion)
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Enregistrer une configuration

ü Vous avez transféré la configuration.

1. Fenêtre Affectation et mise à jour automatique du micrologiciel : 
cliquez sur Enregistrer les valeurs (A00) ....

ð La fenêtre Enregistrer les valeurs (A00) s'ouvre.

2. Cliquez sur Démarrer l'action.

ð La configuration est enregistrée.

3. Fermez la fenêtre Enregistrer les valeurs (A00).

4. Fenêtre Affectation et mise à jour automatique du micrologiciel : 
cliquez sur Redémarrer (A09) ....

ð La fenêtre Redémarrer (A09) s'ouvre.

5. Cliquez sur Démarrer l'action.

6. Cliquez surOK pour confirmer la consigne de sécurité.

ð La fenêtre Redémarrer (A09) se ferme.

ð La communication par bus de terrain et la connexion vers DriveControlSuite sont interrompues.

ð Les servo-variateurs redémarrent.

8.3.5 Créer et enregistrer un fichier ESI
Les fonctions et les caractéristiques des servo-variateurs STOBER sont décrites sous forme de différents objets et résumées
dans un fichier ESI. 
Pour pouvoir reproduire et configurer un ou plusieurs servo-variateurs dans le réseau, générez un ESI de votre application
planifiée et mettez-le à disposition dans le TwinCAT System Manager dans le répertoire indiqué ci-dessous.

Information

Notez que TwinCAT ne peut lire qu'un seul fichier ESI par gamme de servo-variateur.
Après chaque modification d'une configuration, il faut générer un nouveau fichier ESI et le mettre à disposition dans
TwinCAT.

ü Vous avez configuré la transmission PDO.

1. Dans l'arborescence de projet, marquez le servo-variateur correspondant et cliquez dans le menu de projet > Zone
Assistant sur le premier axe planifié.

2. Sélectionnez l'assistant EtherCAT.

3. Cliquez sur Créer un ESI.

ð La boîte de dialogue Écrire fichier ESI s'ouvre.

4. Enregistrez le fichier XML dans le répertoire C:\TwinCAT\IO\EtherCAT (installation standard).

ð TwinCAT charge le fichier lors d'un nouveau redémarrage du programme.
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8.4 TwinCAT 3 : mettre en service le système EtherCAT
TwinCAT 3 offre la possibilité de reproduire votre environnement matériel via TwinCAT XAE. 
Vous paramétrez automatiquement tous les paramètres de bus nécessaires dans le logiciel par numérisation matérielle.
Configurez ensuite un programme de sécurité individuel qui commande les signaux d'exigence de sécurité STO et SS1. 
Des modules fonctionnels prédéfinis que vous reliez aux entrées et sorties souhaitées sont disponibles à cet effet. La
configuration d'un programme de sécurité est décrite ci-dessous à l'exemple du module fonctionnel safeEstop (Emergency
Stop).
Transférez enfin le programme de sécurité prêt vers le Maître FSoE.

Notez que tous les participants au système FSoE doivent être clairement identifiables par une adresse FSoE- individuelle
(réglage par commutateur DIP) dans le réseau EtherCAT. Affectez les adresses FSoE avant le montage et l'interconnexion
des différents appareils et bornes.

Information

Exécutez impérativement les étapes contenues dans les chapitres ci-après dans l'ordre indiqué !

Certains paramètres de DriveControlSuite sont dépendants les uns des autres et ne seront accessibles que si vous avez
procédé auparavant à certains réglages. Suivez les étapes dans l'ordre prescrit afin de de pouvoir finaliser intégralement le
paramétrage.

8.4.1 Activer le Maître EtherCAT

ü Vous avez planifié au préalable tous les servo-variateurs de votre système via DriveControlSuite et transmis la
configuration de projet aux différents servo-variateurs. Le Maître EtherCAT est raccordé au réseau, tous les
composants de sécurité possèdent une adresse FSoE, sont sous tension et l'infrastructure est opérationnelle. Vous
avez enregistré le fichier ESI généré dans le répertoire indiqué. Les fichiers ESI des appareils Beckhoff sont déjà
mémorisés dans le système TwinCAT.

1. Démarrez TwinCAT XAE.

ð Le fichier ESI mémorisé est chargé au démarrage du programme et la fenêtre principale du TwinCAT System
Manager s'ouvre. L'onglet Start Page est actif.

2. Sélectionnez File > New > Project.

ð La boîte de dialogue New Project s'ouvre.

3. Sélectionnez Installed > Templates > TwinCAT Projects > TwinCAT XAE Project (XML format).

4. Name, Location, Solution name : 
nommez le projet, indiquez un emplacement d'enregistrement et un nom de projet interne.

5. Fermez la boîte de dialogue.

6. Si Run-Time (Maître EtherCAT) et TwinCAT XAE ont été installés sur un ordinateur personnel, ils sont
automatiquement interconnectés. Continuez avec l'étape 12.

7. Si Run-Time (Maître EtherCAT) et TwinCAT System Manager ont été installés sur différents ordinateurs, vous devez les
interconnecter. 
Dans la barre d'outils TwinCAT XAE cliquez sur la zone de liste <Local> et sélectionnez Choose Target System.

ð La boîte de dialogue Choose Target System s'ouvre.

8. Cliquez sur Search (Ethernet).

ð La boîte de dialogue Add Route s'ouvre.

9. Cliquez sur Broadcast Search.

ð Toutes les commandes disponibles sont énumérées.
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10. Marquez la commande souhaitée, activez l'option IP Address et confirmez avec Add Route.

ð La boîte de dialogue Logon Information s'ouvre.

11. Dans le cas d'un appareil neuf, entrez les données suivantes (accès par défaut TwinCAT) et confirmez avec OK:
User name : Administrator
Password : 1

12. Fermez la boîte de dialogue.

13. Boîte de dialogue Choose Target System : 
marquez le Maître EtherCAT sélectionné au préalable et confirmez avec OK.

ð Le Maître EtherCAT est enregistré comme système cible.

14. Pour pouvoir configurer le système EtherCAT en ligne, vous devez activer le mode de configuration (Config Mode) du
logiciel TwinCAT XAE. 
Sélectionnez le menu TWINCAT > Restart TwinCAT (Config Mode).

ð La boîte de dialogue Restart TwinCAT System in Config Mode s'ouvre.

15. Cliquez sur OK pour confirmer.

ð Le Maître EtherCAT est enregistré comme système cible, XAE est en mode Config.

8.4.2 Numériser l'environnement matériel
Si tous les composants système sont raccordés au réseau EtherCAT et si ce dernier est sous tension, il est possible
d'effectuer une numérisation automatique selon les participants au système. Dans ce cas, TwinCAT XAE cherche les
appareils et bornes connectés et les intègre dans le projet existant conformément à leurs entrées dans les fichiers ESI
correspondants.

Si la véritable infrastructure EtherCAT n'est pas disponible, c.-à-d. si vous effectuez la configuration en mode hors ligne,
vous devez reproduire et planifier manuellement tous les participants au système dans TwinCAT XAE. Vous trouverez de
plus amples informations à ce sujet dans l'aide en ligne du logiciel TwinCAT XAE.

ü Vous avez activé le mode Config.

1. Dans Solution Explorer, naviguez vers I/O > Devices > Menu contextuel Scan.

ð TwinCAT XAE numérise le système EtherCAT selon le Maître EtherCAT. 
La boîte de dialogue ... new I/O devices found s'ouvre.

2. Activez le Maître EtherCAT et confirmez avec OK.

ð Le Maître EtherCAT est créé dans Solution Explorer sous I/O > Devices comme Device (EtherCAT). 
La boîte de dialogue Scan for boxes? s'ouvre.

3. Confirmez avec Yes.

ð TwinCAT XAE numérise le système EtherCAT selon les Esclaves EtherCAT.
La boîte de dialogue EtherCAT drive(s) added s'ouvre.

4.  Append linked axis to :
si vous avez besoin d'une fonctionnalité NC ou CNC, activez l'option souhaitée et confirmez avec OK.

ð Dans Solution Explorer, les coupleurs de bus des Esclaves EtherCAT (borne EK1100) avec le Maître FSoE (borne
EL6900) et les entrées sûres (bornes EL1904) ainsi que le servo-variateur sont créés. 
La boîte de dialogue Activate Free Run s'ouvre.

5. Afin de mettre les composants système durant leur configuration dans un mode de marche libre (Free Run) et de
pouvoir ainsi vérifier l'échange de signaux, confirmez avec Yes.

ð Le Maître et les Esclaves EtherCAT sont créés dans TwinCAT XAE.
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8.4.3 Configurer le projet TwinCAT SAFETY
Un TwinCAT SAFETY est composé d'un groupe TwinSAFE avec des Alias Devices, c.-à.d. les composants matériels de votre
système, ainsi que l'élément SAFETY même avec tous les modules fonctionnels correspondants qui représentent la logique
de sécurité. Les modules fonctionnels possèdent des paramètres qui doivent être configurés de manière spécifique à
l'application.

Dans la première étape créez un projet SAFETY avec tous les Alias Devices et configurez ensuite, par exemple, le module
fonctionnel safeEstop.

8.4.3.1 Créer un projet TwinCAT SAFETY

1. Naviguez dans Solution Explorer vers SAFETY > Menu contextuel Add New Item.

ð La boîte de dialogue Add New Item s'ouvre.

2. Marquez l'entrée TwinCAT Default Safety Project.

3. Name : 
nommez le projet SAFETY et confirmez avec Add.

ð La boîte de dialogue TwinCAT Safety Project Wizard s'ouvre.

4. Internal Project Name : 
si nécessaire, attribuez un nom de projet interne au système et confirmez avec OK.

ð Dans Solution Explorer le projet SAFETY, un système cible, ainsi qu'un groupe TwinSAFE sont créés sous le nom
que vous avez attribué. Le groupe TwinSAFE comporte déjà un dossier pour les Alias Devices devant encore être
créés ; l'Alias Device ErrorAcknowledgement.sds comme entrée Reset est disponible par défaut.

5. Pour définir le Maître FSoE comme système cible, sélectionnez dans Solution Explorer le nouveau projet SAFETY et
double-cliquez sur Target System.

6. Fenêtre principale > Physical Device : 
cliquez sur l'icône correspondante.

ð La boîte de dialogue Choose physical terminal for mapping s'ouvre.

7. Terminal : 
marquez le Maître FSoE EL6900 et confirmez avec OK.

8. Fenêtre principale > Hardware Address : 
l'adresse FSoE du Maître FSoE a été automatiquement chargée vers TwinCAT XAE.

9. Pour enregistrer le projet, sélectionnez le menu FILE > Safe Selected Items.

ð Le projet SAFETY est créé et le Maître FSoE est configuré comme système cible correspondant.
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8.4.3.2 Créer des Alias Devices

Le matériel requis pour le projet SAFETY est intégré comme Alias Device correspondant dans le groupe TwinSAFE.

1. Naviguez dans Solution Explorer vers votre projet SAFETY > TwinSafeGroup1 > Alias Devices > Menu contextuel Add >
New Item.

ð La boîte de dialogue Add New Item s'ouvre.

2. Créez un Alias Device comme entrée pour le démarrage du groupe TwinSAFE. 
Sélectionnez  Installed > Standard  > 1 Digital Input (Standard).

3. Name : 
nommez l'Alias Device avec RUN et confirmez avec Add.

4. Dans Solution Explorer, sélectionnez à nouveau le dossier Alias Devices > Menu contextuel Add > New Item.

5. Créez un Alias Device pour les entrées sûres (borne EL1904). 
Sélectionnez  Safety  > EtherCAT > Beckhoff Automation GmbH > 4 Digital Inputs.

6. Name : 
si nécessaire, nommez le Device et confirmez avec Add.

7. Dans Solution Explorer, sélectionnez à nouveau le dossier Alias Devices > Menu contextuel Add > New Item.

8. Créez un Alias Device pour le servo-variateur avec module de sécurité SY6 intégré. 
Sélectionnez  Safety  > EtherCAT > STOEBER ANTRIEBSTECHNIK GmbH & Co. KG > 0xB1EC5956 - Safety (FSoE).

9. Name : 
si nécessaire, nommez le Device et confirmez avec Add.

ð Les composants matériels mentionnés sont créés comme Alias Devices du groupe TwinSAFE dans Solution Explorer.

8.4.3.3 Affecter les Alias Devices et entrer les adresses FSoE

Affectez les Alias Devices créés aux différents composants matériels de votre système et attribuez les adresses FSoE
correspondantes.

1. Dans Solution Explorer, naviguez vers votre projet SAFETY > TwinSafeGroup1 > Alias Devices et double-cliquez sur
ErrorAcknowledgement.sds.

2. Fenêtre principale > Full Name : 
cliquez sur l'icône correspondante.

ð La boîte de dialogue Attach Variable Standard In Var 1 (Output) s'ouvre.

3. Show Variables :
pour afficher tous les appareils, activez l'option Used and unused.

4. Show Variables : 
pour afficher les entrées par défaut, désactivez la case Exclude other Devices.

5. Sélectionnez l'entrée par défaut souhaitée pour la réinitialisation du groupe TwinSAFE et confirmez avec OK.

6. Dans Solution Explorer, sélectionnez le dossier Alias Devices et double-cliquez sur RUN.sds.

7. Fenêtre principale > Full Name : 
cliquez sur l'icône correspondante.

ð La boîte de dialogue Attach Variable Standard In Var 1 (Output) s'ouvre.

8. Sélectionnez l'entrée par défaut souhaitée pour le démarrage du groupe TwinSAFE et confirmez avec OK.

ð Les entrées matérielles par défaut pour la réinitialisation et le démarrage du groupe TwinSAFE-Gruppe sont
connectées aux Alias Devices correspondants.

9. Dans Solution Explorer, sélectionnez le dossier Alias Devices et double-cliquez sur 4 digital inputs_1.sds.
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10. Fenêtre principale > Onglet Linking > Physical Device : 
Cliquez sur l'icône correspondante.

ð La boîte de dialogue Choose physical channel s'ouvre.

11. Sélectionnez le premier module de la borne EL1904 et confirmez avec OK.

ð La borne EL1904 est connectée à l'Alias Device correspondant.

12. Onglet Linking > FSoE Address : 
L'adresse FSoE de la borne EL1904 a été automatiquement chargée dans TwinCAT XAE lors de la numérisation
matérielle, champ Dip Switch. Pour accepter cette adresse, cliquez sur l'icône correspondante.

ð L'adresse est transférée du champ Dip Switch vers le champ FSoE Address.

13. Dans Solution Explorer, sélectionnez le dossier Alias Devices et double-cliquez sur 0xB1EC5956 – Safety(FSoE).sds.

14. Fenêtre principale > Onglet Linking > Physical Device : 
Cliquez sur l'icône correspondante.

ð La boîte de dialogue Choose physical channel s'ouvre.

15. Sélectionnez le premier module du servo-variateur avec le module de sécurité intégré SY6 et cliquez sur OK pour
confirmer.

ð Le servo-variateur est connecté à l'Alias Device correspondant.

16. Onglet Linking > FSoE Address : 
L'adresse FSoE du module de sécurité a été automatiquement chargée dans TwinCAT XAE lors de la numérisation
matérielle, champ Dip Switch. Pour accepter cette adresse, cliquez sur l'icône correspondante.

ð L'adresse est transférée du champ Dip Switch vers le champ FSoE Address.

17. Pour paramétrer la temporisation SS1 après l'expiration de laquelle la fonction STO est automatiquement déclenchée,
sélectionnez dans la fenêtre principale > Onglet Safety Parameters > Parameter T_SS1.

18. T_SS1 :
double-cliquez sur l'entrée.

ð La boîte de dialogue Set Value s'ouvre.

19. Dec. : 
paramétrez la temporisation SS1 souhaitée et confirmez avec OK.

ð Notez que la valeur paramétrée ici est multipliée à l'intérieur du système par le facteur 10 (ex. : T_SS1 = 100,
correspond à 1000 ms). 
T_SS1 s'affiche dans le paramètre S593 SS1 temps jusqu'à STO de DriveControlSuite.

ð Les composants matériels sont connectés aux Alias Devices correspondants et les adresses FSoE sont entrées.
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8.4.3.4 Configurer un module fonctionnel

Via le module fonctionnel safeEstop, configurez un bouton-poussoir d'arrêt d'urgence relié à la borne d'entrée sûre EL1904
via deux contacts à ouverture.

8.4.3.4.1 Créer un module fonctionnel et affecter les sources de signaux

1
3

2

4 5

Fig. 4: TwinCAT 3 – configurez le module fonctionnel « safeEstop » et affectez les sources de signaux

1. Dans Solution Explorer, naviguez vers votre projet SAFETY > TwinSafeGroup1 et double-cliquez sur
TwinSafeGroup1.sal (1).

2. Menu VIEW (2) : 
ouvrez l'affichage Toolbox.

3. Toolbox > FunctionBlocks (boolean) (3) : 
glissez-déposez le module safeEstop dans la fenêtre principale > Onglet TwinSafeGroup1.sal.

4. Cliquez à gauche près de l'icône Restart.

5. Nommez la variable avec RestartInput.

6. Cliquez à gauche près de chaque icône EStopIn1 et EStopIn2.

7. Nommez les variables avec Channel1 et Channel2.

8. Cliquez à droite près de chaque icône EStopOut et EStopDelOut.

9. Nommez les variables avec Stop et StopVerz.
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10. Delay Time (ms) : 
dans T_SS1  indiquez la temporisation SS1. 
Notez que la valeur dans ce champ d'entrée n'est PAS multipliée à l'intérieur du système par le facteur 10.

ð Toutes les variables nécessaires à la configuration du module fonctionnel safeEstop sont créées.

11. Dans l'affichage Message, passez à l'onglet Variable Mapping > Sous-onglet Variables (4).

ð Les variables définies au préalable pour le module fonctionnel sont énumérées dans la colonne Assigned Variable.

12. Variable RestartInput > Colonne Alias Port : 
cliquez sur le bouton correspondant.

ð La boîte de dialogue Map to s'ouvre.

13. Usage : 
activez l'option Used and unused.

14. Affectez à la variable l'Alias Device ErrorAcknowledgement et confirmez avec OK.

15. Sous-onglet Variables > Variables Channel1 et Channel2 > Colonne Alias Port : 
cliquez sur les boutons correspondants.

ð La boîte de dialogue Map to s'ouvre.

16. Affectez à la variable Channel1 l'Alias Device 4 digital inputs > Channel1 > InputChannel1 et la variable Channel2 4
digital inputs > Channel2 > InputChannel2 et confirmez avec OK.

17. Sous-onglet Variables > Variables Stop et StopVerz > Colonne Alias Port : 
cliquez sur les boutons correspondants.

ð La boîte de dialogue Map to s'ouvre.

18. Affectez à la variable Stop l'Alias Device 0xB1EC5956 - Safety (FSoE)  > Channel > SS1 et à la variable StopVerz l'Alias
Device 0xB1EC5956 - Safety (FSoE)  > Channel > STO et confirmez avec OK.

ð Toutes les variables configurées du module fonctionnel safeEstop sont connectées aux Alias Devices
correspondants.

19. Passez au sous-onglet Group Ports (5).

20. Variables ErrAck et Run/Stop > Colonne Alias Port : 
cliquez sur les boutons correspondants.

ð La boîte de dialogue Map to s'ouvre.

21. Usage : 
activez l'option Used and unused.

22. Affectez à chaque variable un Alias Device ErrorAcknowledgement et RUN du groupe TwinSAFE et confirmez avec OK

ð Le module fonctionnel configuré est prêt pour le téléchargement vers le Maître FSoE.
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8.4.3.4.2 Transférer un module fonctionnel

Validez le module fonctionnel configuré et transférez-le vers le Maître FSoE.

1. Dans Solution Explorer, naviguez vers votre projet SAFETY > TwinSafeGroup1 et double-cliquez sur
TwinSafeGroup1.sal.

2. Sélectionnez le menu TWINSAFE > Verify Complete Safety Project.

3. Une fois la validation effectuée, l'état VERIFICATION PROCESS SUCCEEDED s'affiche à gauche du bas de page de l'interface
TwinCAT XAE.

4. Sélectionnez le menu TWINSAFE > Download Safety Project.

ð La boîte de dialogue Check if the addresses configured on hardware terminals [...] s'ouvre.

5. Confirmez la requête avec Yes.

ð La boîte de dialogue Download Project Data > Steps: Login s'ouvre. 
Le téléchargement vers le Maître FSoE est protégé par un mot de passe.

6. Zone Login :
dans le cas d'un appareil neuf, indiquez les données suivantes (accès par défaut TwinCAT) et confirmez avec Next: 
Username: Administrator
Serial Number: numéro de série du Maître FSoE
Password: TwinSAFE

ð La boîte de dialogue Download Project Data > Steps: Download s'ouvre.

7. Cliquez sur Next pour lancer le téléchargement en aval.

ð La boîte de dialogue Download Project Data > Steps: Final Verification s'ouvre.

8. Zone Final Verification > Demande de confirmation  I have manually verified the data shown [...] :
vérifiez les données configurées, confirmez la demande de confirmation en activant la case correspondante et cliquez
sur Next.

ð La boîte de dialogue Download Project Data > Steps: Activation s'ouvre.

9. Zone Activation > Password : 
entrez à nouveau le mot de passe TwinSAFE et confirmez avec Finish.

ð Le module fonctionnel est transféré vers le Maître FSoE.

10. Redémarrez le système TwinCAT : 
sélectionnez le menu Actions > Set/Reset TwinCAT to Config Mode.

ð La boîte de dialogue Restart TwinCAT System in Config Mode s'ouvre.

11. Cliquez sur OK pour confirmer.

8.4.4 Vérifier la fonctionnalité du groupe TwinSAFE
Vérifiez le bon fonctionnement du groupe TwinSAFE.

1. Dans Solution Explorer, naviguez vers votre projet SAFETY > TwinSafeGroup1 et double-cliquez sur
TwinSafeGroup1.sal.

2. Sélectionnez le menu TWINSAFE > Show Online Data.

ð Le Maître FSoE (borne EL6900) est à l'arrêt, le module fonctionnel safeEstop est désactivé, l'état correspondant
est défini sur Rouge.

3. Démarrez le groupe TwinSAFE via RUN = true.

4. Déverrouillez le bouton d'arrêt d'urgence et appuyez sur la touche Reset.

ð Le module fonctionnel n'est pas actif, le groupe TwinSAFE ne fonctionne pas correctement.
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9 Diagnostic
En cas de dérangement, vous pouvez opter pour une des possibilités de diagnostic décrites ci-après.

9.1 Affichage DEL
Les servo-variateurs STOBER sont équipés de DEL de diagnostic qui visualisent l'état de la communication par bus de terrain
ainsi que les états de la connexion physique.

9.1.1 État EtherCAT
2 DEL situées sur la face avant du servo-variateur informent de l'état de la communication entre le Maître et l'Esclave
EtherCAT et celui de l'échange de données. Celui-ci peut être également consulté dans le paramètre A255 État dispositif
EtherCAT. Si le servo-variateur est doté du module de sécurité SY6, les fonctions de sécurité STO et SS1 sont contrôlées via
EtherCAT FSoE. Dans ce cas, une DEL additionnelle placée sur la face avant de l'appareil informe sur l'état FSoE.

2

1 Err

Run

FSoE

Fig. 5: DEL indiquant l'état EtherCAT

1 Rouge : Error

2 Verte : Run
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DEL rouge Comportement Erreur Description

Éteinte No Error Aucune erreur

Clignotement Invalid Configuration Configuration invalide

Clignote 1 fois Unsolicited State Change L'Esclave EtherCAT a automatiquement
changé d'état de service

2 clignotements Temporisation de
l'application Watchdog

L'Esclave EtherCAT n'a reçu aucune nouvelle
donnée PDO pendant la temporisation
paramétrée du Watchdog

Tab. 2: Signification des DEL rouges (Error)

DEL verte Comportement État de service Description

Éteinte Init Aucune communication entre le Maître et
l'Esclave EtherCAT ; la configuration
démarre, les valeurs enregistrées sont
chargées

Clignotement Pre-Operational Aucune communication PDO ; le Maître et
l'Esclave EtherCAT échangent les paramètres
spécifiques aux applications par le biais de la
communication SDO

Clignote 1 fois Safe-Operational L'Esclave EtherCAT envoie les valeurs réelles
actuelles au Maître EtherCAT, ignore ses
valeurs de consigne et a plutôt recours aux
valeurs par défaut internes

Allumée Operational Mode de fonctionnement normal : le Maître
et l'Esclave EtherCAT échangent les valeurs
de consigne et les valeurs réelles

Tab. 3: Signification de la DEL verte (Run)
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9.1.2 État FSoE
Si le servo-variateur est doté du module de sécurité SY6, les fonctions de sécurité STO et SS1 sont contrôlées via
EtherCAT FSoE. Dans ce cas, une DEL située sur la face avant de l'appareil informe sur l'état de la communication FSoE.
Celui-ci peut être également consulté dans le paramètre S20 FSoE status indicator.

1

Err

Run

FSoE

Fig. 6: DEL pour l'état FSoE

1 Verte : FSoE

DEL verte Comportement Description

Éteinte Initialisation

Clignotement Prêt pour le paramétrage

Allumée Fonctionnement normal

Flash simple Commande Failsafe reçue du Maître FSoE

Flash Erreur de connexion indéfinie

Flash avec
1 clignotements

Erreur dans les paramètres de communication relatifs à la sécurité

Flash avec
2 clignotements

Erreur dans les paramètres d'application relatifs à la sécurité

Flash avec
3 clignotements

Adresse FSoE erronée

Flash avec
4 clignotements

Commande non autorisée reçue

Flash avec
5 clignotements

Erreur chien de garde

Flash avec
6 clignotements

Erreur CRC

Tab. 4: Signification de la DEL verte (FSoE status indicator conformément à CEI 61784-3)
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9.1.3 Connexion réseau EtherCAT
Les diodes électroluminescentes LA ECIN et LA ECOUT sur les bornes X200 et X201 sur la partie supérieure de l'appareil
indiquent l'état de la connexion réseau EtherCAT.

LA
LA

IN
EC

X
2
0
0
:

O
U
T

EC
X
2
0
1
:

2

4

3

1

Fig. 7: Diodes électroluminescentes indiquant l'état de la connexion réseau EtherCAT

1 Vert : LA ECOUT à X201

2 Jaune : sans fonction

3 Vert : LA ECIN à X200

4 Jaune : sans fonction

DEL verte Comportement Description

Désactivé Aucune connexion réseau

Clignotement Échange de données actif avec d'autres participants EtherCAT

Activé Connexion réseau établie

Tab. 5: Signification des DEL vertes (LA)
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9.2 Paramètres
Les paramètres de diagnostic suivants sont disponibles dans le cadre de la technique de sécurité avec les servo-variateurs
de la gamme SC6 ou SI6 et le module de sécurité SY6.

9.2.1 E54 | Information module sécurité | V0
Caractéristiques clés du module de sécurité.

§ [0] : type

§ [1] : version du matériel

§ [2] : numéro de production

§ [3] – [5] : réservés

§ [6] : code de diagnostic

9.2.2 E67 | État STO | V1
État STO du module de sécurité :

§ [0] : STO a été déclenché par le signal d'entrée STOa = 0 ou STOb = 0

• 0: Inactif = pas déclenché

• 1: Actif = déclenché

§ [1] : STO a été déclenché par le signal d'entrée STOa = 0

• 0: Inactif = pas déclenché

• 1: Actif = déclenché

§ [2] : STO a été déclenché par le signal d'entrée STOb = 0

• 0: Inactif = pas déclenché

• 1: Actif = déclenché

9.2.3 S20 | FSoE status indicator | V0
État de la transmission de données de sécurité via FSoE.

Correspond au FSoE status indicator conformément à CEI 61784-3.

Normal

§ 0 hex = initialisation
Possible à l'état FSoE Pre-Reset

§ 1 hex = prêt pour le paramétrage par le Maître FSoE
Possible dans les états FSoE Reset, Session, Connection, Parameter

§ 2 hex = fonctionnement normal
Possible à l'état FSoE Process Data

§ 3 hex = commande Failsafe reçue par le Maître FSoE
Possible à l'état FSoE Failsafe Data
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Erreur

§ 4 hex = erreur de connexion indéfinie
Possible dans tous les états FSoE

§ 5 hex = erreur dans les paramètres de communication relatifs à la sécurité
Possible dans le paramètre État FSoE

§ 6 hex = erreur dans les paramètres d'application relatifs à la sécurité
Possible dans le paramètre État FSoE

§ 7 hex = adresse FSoE erronée 
Possible à l'état FSoE Connection

§ 8 hex = commande inadmissible reçue via l'interface de communication FSoE
Possible dans tous les états FSoE

§ 9 hex = temporisation de la transmission des données (chien de garde)
Possible dans tous les états FSoE

§ A hex = transmission de données incohérente (somme de contrôle CRC)
Possible dans tous les états FSoE

9.2.4 S21 | FSoE adresse esclave | V0
Adresse du servo-variateur (Esclave FSoE) dans le réseau EtherCAT (condition préalable : le Maître FSoE est actif ; source :
commutateurs DIP).

Les changements d'adresse sont appliqués au redémarrage du servo-variateur.

9.2.5 S25 | Code diagnostique SY6 | V0
Octet d'état avec code de diagnostic du module de sécurité.

§ Bit 0 : erreur de canal OSSD interne

§ Bit 1 : réservé

§ Bit 2 : erreur de communication FSoE

§ Bit 3 : réservé

§ Bit 4 : surtempérature

§ Bit 5 : réservé

§ Bit 6 : temps SS1
0 = inactif ; 1 = actif

§ Bit 7 : état STO
1 = en état hors tension

Sauf indication contraire : 0 = inactif ; 1 = actif
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9.2.6 S27 | FSoE durée du chien de garde | V0
Durée de défaillance tolérée de télégrammes FSoE pour la surveillance de la communication FSoE dans le réseau EtherCAT
(utilisation : déclenchement STO interne ; source : Maître FSoE).

La surveillance FSoE est indépendante de la surveillance PDO et est prédéfinie par le Maître FSoE(surveillance PDO : A258).

9.2.7 S130 | Temps de service | V0
Temps de fonctionnement du module de sécurité.

9.2.8 S544 | Safety controlword | V0
Octet de commande pour FSoE.

Correspond à l'objet de communication Safety controlword selon ETG.6100.1 ; objet 6620 hex.

§ [0] : premier octet
Correspond à l'objet de communication 1st byte selon ETG.6100.1 ; sous-index 1 hex

• Bit 0 : STO
0 = activer STO ; 1 = ne pas activer STO

• Bit 1 : SS1
0 = activer SS1 ; 1 = ne pas activer SS1

• Bit 2 – 7 : réservés

§ [1] : deuxième octet : réservé
Correspond à l'objet de communication 1st byte conformément à ETG.6100.1 ; sous-index 2 hex

Le bit 0 et le bit 1 doivent être définis sur 1 pour l'autorisation du bloc de puissance.

9.2.9 S545 | Safety statusword | V0
Octet d'état pour FSoE.

Correspond à l'objet de communication Safety statusword selon ETG.6100.1 ; objet 6621 hex.

§ [0] : premier octet
Correspond à l'objet de communication 1st byte selon ETG.6100.1 ; sous-index 1 hex

• Bit 0 : STO
1 = STO actif

• Bit 1 – 7 : réservés

§ [1] : deuxième octet : réservé
Correspond à l'objet de communication 1st byte conformément à ETG.6100.1 ; sous-index 2 hex

9.2.10 S593 | SS1 temps jusqu'à STO | V0
Temporisation SS1, c.-à-d. durée entre l'activation d'un SS1 basé sur le temps par S544 Safety controlword, le bit 1 et le
déclenchement interne de la fonction STO (unité : 10 ms ; source : Maître FSoE).

Correspond à l'objet de communication SS1 temps jusqu'à STO selon ETG.6100.1 ; objet 6651 hex.

Un changement de la temporisation SS1 dans le Maître FSoE prend effet avec le prochain redémarrage du Maître FSoE et
est visible dans le paramètre S593.
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9.3 Événements
Le servo-variateur est équipé d'un système d'auto-surveillance qui protège le système d'entraînement de dommages grâce
à des règles de contrôle. La violation des règles de contrôle déclenche un événement correspondant. En qualité
d'utilisateur, vous n'avez aucune influence sur certains événements, comme par exemple un Court-circuit/mise à la terre.
En revanche, vous pouvez influencer les incidences et les réactions d'autres événements.

Incidences possibles :

§ Message : information pouvant être analysée par la commande

§ Avertissement : information pouvant être analysée par la commande et qui se transforme en dérangement au bout
d'une période définie si la cause n'a pas été éliminée

§ Dérangement : réaction immédiate du servo-variateur ; le bloc de puissance est bloqué et le mouvement de l'axe n'est
plus contrôlé par le servo-variateur ou l'axe est immobilisé à la suite d'un arrêt rapide ou d'un freinage d'urgence

ATTENTION !

Dommage matériel dû à l'interruption de l'arrêt rapide ou au freinage d'urgence

Si un autre dérangement survient pendant l'exécution d'un arrêt rapide ou pendant un freinage d'urgence, ou si une
fonction de sécurité est activée, l'arrêt rapide ou le freinage d'urgence sont interrompus. Dans ce cas, il y a risque
d'endommagement de la machine dû à un mouvement incontrôlé de l'axe.

Les événements, leurs causes inhérentes et les mesures appropriées sont énumérés ci-dessous. Une fois la cause de l'erreur
éliminée, vous pouvez en règle générale acquitter l'erreur directement. Si, par contre, un redémarrage du servo-variateur
est nécessaire, vous trouverez une indication correspondante dans les mesures.

9.3.1 Événement 50 : Module de sécurité
Le servo-variateur bascule dans l'état de dérangement :

§ Le bloc de puissance est verrouillé et le servo-variateur ne contrôle plus le mouvement de l’axe

§ Les freins ne sont plus contrôlés par le servo-variateur et se serrent lorsque la commande prioritaire de déblocage est
inactive (F06)

Cause Contrôle et mesure

2: Module sécurité erroné Le module de sécurité planifié E53
ne correspond pas au E54[0]
détecté par le système

Contrôlez la planification et le servo-variateur
et, le cas échéant, corrigez la planification ou
remplacez le servo-variateur ; le dérangement
n'est pas validable

3: Erreur interne Module de sécurité défectueux Remplacez le servo-variateur ; le dérangement
n'est pas validable

16: Validation hors service ! Requête STO lorsque le bloc de
puissance est actif

Envoyer une requête STO seulement lorsque le
bloc de puissance est inactif

Envoyer simultanément à la requête STO une
requête d'autorisation désactivée sans arrêt
rapide (Drive Based A44)

Tab. 6: Événement 50 – Causes et solutions
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9.3.2 Événement 70 : Consistance des paramètres
Le servo-variateur bascule dans l'état de dérangement :

§ Le bloc de puissance est verrouillé et le servo-variateur ne contrôle plus le mouvement de l’axe

§ Les freins ne sont plus contrôlés par le servo-variateur et se serrent lorsque la commande prioritaire de déblocage est
inactive (F06)

Cause Contrôle et mesure

15: FSoE durée du chien de garde Rapport trop faible entre le temps
du chien de garde FSoE et la
temporisation EtherCAT PDO

Vérifiez le temps du chien de garde FSoE dans
le Maître FSoE et la temporisation EtherCAT
PDO dans le servo-variateur et augmentez le
temps du chien de garde ou réduisez la
temporisation PDO si nécessaire (valeur
indicative : temps du chien de garde FSoE =
temporisation EtherCAT PDO + 100 ms ; S27,
A258)

Tab. 7: Événement 70 – Causes et mesures

9.4 Paramètres du Maître FSoE
Lors de l'établissement de la connexion, le module de sécurité SY6 attend dans l'état FSoE Paramètres du Maître FSoE les
Process Data Units (PDU) suivants dans l'ordre indiqué. Les Process Data Units sont les paquets de données échangés entre
le Maître FSoE et l'Esclave FSoE :

PDU Octet Valeur Description

PDU 1 SafeData[0] 0x02 2 octets, longueur des paramètres de
communicationSafeData[1] 0x00

PDU 2 SafeData[0] T_WD octet Low Temps du chien de garde FSoE en ms ;
plage de valeurs : 12 à 65534 msSafeData[1] T_WD octet High

PDU 3 SafeData[0] 0x06 6 octets, longueur des paramètres d'application

SafeData[1] 0x00

PDU 4 SafeData[0] 0x01 Numéro d'identification SY6 ;
Valeur = 1 (réglage fixe !)SafeData[1] 0x00

PDU 5 SafeData[0] 0x00

SafeData[1] 0x00

PDU 6 SafeData[0] T_SS1 octet Low Temporisation en s ;
plage de valeurs : 0 à 655,35 s ;
Résolution : 1 LSB = 10 ms

SafeData[1] T_SS1 octet High

Tab. 8: Process Data Units dans l'état FSoE Paramètres
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10 Plus d'informations sur FSoE, les fonctions de
sécurité et SY6 ?

Ce chapitre résume les principales notions, relations et mesures autour de FSoE, des fonctions de sécurité STO et SS1 ainsi
que du module de sécurité SY6.

10.1 FSoE : Fail Safe over EtherCAT
Il existe, parallèlement au système Ethernet en temps réel EtherCAT, un protocole Safety appelé Safety over EtherCAT
(FSoE = Fail Safe over EtherCAT) pour la transmission de messages de sécurité entre les appareils FSoE dans un réseau. Le
protocole est certifié TÜV et fait l'objet d'une normalisation internationale sous forme de la norme CEI 61784-3. La
conception FSoE repose sur le principe Black-Channel.

Communication sûre

Dans chaque cycle FSoE un Maître FSoE envoie des données de sécurité à un Esclave FSoE et démarre simultanément une
horloge chien de garde. L'Esclave FSoE acquitte les données reçues avant qu'elles ne soient retournées au Maître et
démarre également une surveillance de la durée de fonctionnement par l'horloge chien de garde. Le Maître reçoit et traite
l'acquittement de l'Esclave et arrête l'horloge chien de garde. Si les données ont été entièrement traitées, le Maître FSoE
génère un nouveau paquet de données.

Adressage FSoE univoque

Chaque Esclave FSoE doit être identifiable via une adresse FSoE univoque.

L'adresse est attribuée via un commutateur DIP directement sur l'appareil. Une adresse valide est disponible dans la plage
d'adresses 1 – 255 (8 bits, adresse 0 ne doit en aucun cas être attribué).

10.2 Fonctions de sécurité
Le module de sécurité SY6 prend en charge les fonctions de sécurité Safe Torque Off (STO) et Safe Stop 1 (SS1-t). La
commande de sécurité doit commander aussi bien la sortie STO que SS1 du servo-variateur s'il est prévu de déplacer l'axe
d'entraînement. Si une seule des sorties est configurée, le servo-variateur reste en état sûr (STO active).

Les fonctions de sécurité se rapportent à l'appareil et ne sont pas spécifiques aux axes. Cela signifie que dans le cas de
variateurs multiaxe, seul le servo-variateur complet peut être défini dans l'état sûr, et non les axes individuellement.
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10.2.1 Safe Torque Off – STO

STO

Torque
on Motor

Speed

t

t

t

t

STO State

1

n

1

On

Fig. 8: Principe de fonctionnement STO conformément à ETG.6100.2

STO correspond à la catégorie d'arrêt 0 conformément à EN 60204.

La fonction STO est la fonction de sécurité la plus fondamentale intégrée dans l’entraînement. La fonction STO empêche
l'effet d'une énergie génératrice de couple sur un moteur raccordé et un démarrage involontaire. L'objectif est l'exclusion
fiable de dommages corporels et matériels dus à un moteur en marche et mis en service par inadvertance.

L'utilisation de la fonction STO convient pour les cas où le moteur s'arrête automatiquement en raison d'un couple de
charge ou par frottement dans un laps de temps suffisamment court – ou dans un environnement dans lequel un arrêt en
roue libre du moteur ne présente aucune importance du point de vue de la sécurité.
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10.2.2 Safe Stop 1 – SS1-t

SS1

Speed

t

t

t

t

STO State

1

On

1

Torque
on Motor

t

1

SS1 State

T_SS1t0 t1

n

Fig. 9: Principe de fonctionnement SS1-t selon ETG.6100.2

t0 Activation SS1

t1 Activation STO

T_SS1 Temporisation SS1

SS1 correspond à la catégorie d'arrêt 1 conformément à CEI 60204-1.

Dans le cas de la fonction SS1-t, la coupure a lieu après une durée configurable.

La fonction de sécurité SS1-t permet la mise à l'arrêt contrôlée d'un moteur qu'elle met ensuite hors couple une fois la
temporisation SS1 paramétrée expirée, c.-à-d. que la fonction de sécurité STO est activée. Le déclenchement de la fonction
STO est temporisé, peu importe si le moteur est déjà à l'arrêt.

Information

Notez que durant la temporisation SS1, le servo-variateur continue de suivre les valeurs de consigne de la commande, ce
qui permet une mise à l'arrêt contrôlée dans le cas d'applications multiaxe.

La temporisation SS1 T_SS1 est un paramètre de sécurité qui est défini dans le logiciel d'automatisation et transmis au
Maître FSoE. Lors de l'initialisation du protocole FSoE, la valeur de ce paramètre est transférée de la commande de sécurité
vers le servo-variateur et s'affiche dans DriveControlSuite via le paramètre S593 SS1 temps jusqu'à STO.
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10.3 SY6 : attribuer l'adresse FSoE
Afin de pouvoir identifier de manière univoque le module de sécurité dans le réseau FSoE, vous devez lui attribuer
manuellement, via un commutateur DIP, une adresse FSoE issue de la plage d'adresses 1 - 255. L'adresse 0 est invalide, 
c.-à-d. que lors de l'attribution de l'adresse 0, la valeur est ignorée et SY6 reste dans l'état STO.

Information

Notez que le servo-variateur doit être coupé avant l'attribution de l'adresse FSoE via le commutateur DIP. L'adresse n'est
appliquée qu'après un redémarrage du servo-variateur.

Entrée de l'adresse FSoE via un commutateur DIP

L'interrupteur DIP pour l'entrée de l'adresse est situé sur la face supérieure du servo-variateur. L'adresse se compose des
valences des commutateurs DIP qui se trouvent sur ON. Le graphique ci-dessous illustre le module de sécurité avec les
commutateurs DIP avec les valences 2 et 8 ; l'adresse FSoE correspondante est 10.

Fig. 10: SY6 – Commutateurs DIP

Numéro d'interrupteur 1 2 3 4 5 6 7 8

Valence – Adresse FSoE 1 2 4 8 16 32 64 128

Tab. 9: Commutateurs DIP et adresses FSoE

Vérifier l'adresse FSoE dans SY6

Vous pouvez vérifier l'adresse FSoE que vous avez attribuée au module de sécurité via le paramètre S21 FSoE adresse
esclave de DriveControlSuite.
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10.4 Horloge système Safety

Horloge système

Capteur Entrée
sûre

Maître
FSoE

Maître
EtherCAT

Maître
EtherCAT

Communication Communication

Temps de
réaction

Temps de
réaction

Temps de
réaction

Temps de
réaction

Temps de
réaction

Temps de
réaction

Servo-variateur

Fig. 11: Temps de réaction et horloge système Safety

On entend par horloge système STO l'intervalle de temps entre la demande de coupure sûre (STO) sur un capteur et la
coupure sûre effective sur le raccordement EtherCAT du servo-variateur.

L'horloge système dépend des temps de réaction des différents composants, ainsi que des durées de communication et de
transmission dans le réseau intégré EtherCAT.

Les processus correspondants sont :

§ Capteur :
mettre à disposition le signal de demande STO

§ Safety-Terminal (entrée sécurisée) :
détecter le signal de demande STO

§ Maître EtherCAT : 
transmettre l'état de l'entrée sûre au Maître FSoE

§ Maître FSoE :
analyser le signal de demande STO

§ Maître EtherCAT : 
transmettre le signal de demande STO au servo-variateur

§ Servo-variateur : 
activer et désactiver STO (temps de coupure STO) ; ce processus se divise en ....

• Durée de traitement EtherCAT dans la pièce de commande

• Temps de transfert du paquet de données vers le module de sécurité SY6

• SY6 : durée d'analyse du paquet de données

• Temps de coupure du bloc de puissance

10.5 Temps du chien de garde FSoE
Afin de détecter d'éventuels dérangements, la communication entre le Maître et l'Esclave FSoE est surveillée par un chien
de garde FSoE. Dès qu'un télégramme FSoE a été envoyé, le Maître ainsi que l'Esclave démarrent ce qu'on appelle un chien
de garde. Si ni le Maître ni l'Esclave ne reçoivent un télégramme de réponse correspondant avant l'expiration du temps du
chien de garde, l'appareil concerné passe à un état hors tension. La durée du chien de garde est prise en compte dans le
calcul du temps de réaction worst case.

Le temps du chien de garde est paramétré séparément pour chaque Esclave dans le Maître FSoE.

Dans le cas de TwinCAT 3, un temps du chien de garde global de 100 ms est réglé par défaut. Si vous souhaitez changer ce
temps par défaut, passez, dans le cas de TwinCAT 3, aux propriétés des Alias Devices correspondants d'un groupe
TwinSAFE.
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11 Annexe

11.1 Objets de communication pris en charge

11.1.1 ETG.6100.3 Safety over EtherCAT Drive Profile: 6600 hex – 67FF hex
Le tableau ci-après contient les objets de communication pris en charge du profil normalisé ETG.6100.3 Safety over
EtherCAT Drive Profile ainsi que leur reproduction sur les paramètres spécifiques STOBER.

Index Subindex PDO
d'émission

PDO de
réception

Nom Commentaire

6600 hex 0 hex — — Time unit Unité : 10 ms

6620 hex Safety controlword Tableau

6620 hex 0 hex — — Highest subindex supported Nombre d'éléments de tableau : 2

6620 hex 1 hex — — Safety controlword, 
1st byte

S544[0]

6620 hex 2 hex — — Safety controlword, 
2nd byte

S544[1] ; 
sans fonction

6621 hex Safety statusword Tableau

6621 hex 0 hex — — Highest subindex supported Nombre d'éléments de tableau : 2

6621 hex 1 hex — — Safety statusword, 
1st byte

S545[0]

6621 hex 2 hex — — Safety statusword, 
2nd byte

S545[1] ; sans fonction

6640 hex 0 hex — — STO command supported Fonction prise en charge = 1

6641 hex 0 hex — — STO restart acknowledge Redémarrage STO sans acquittement = 0

6650 hex 0 hex — — SS1 command supported Fonction prise en charge = 1

6651 hex 0 hex — — SS1 time to STO S593, unité définie dans l'objet 6600 hex

Tab. 10: Objets de communication ETG.6100.3: 6600 hex – 67FF hex
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11.1.2 ETG.5001.4 Safety over EtherCAT: E000 hex – EFFF hex
Le tableau ci-après contient les objets de communication pris en charge du profil normalisé ETG.5001.4 Safety over
EtherCAT.

Index Subindex PDO
d'émission

PDO de
réception

Nom Commentaire

E901 hex FSoE Connection
Communication Parameter

Structure

E901 hex 0 hex — — Highest subindex
supported

Nombre d'éléments structurels : 8

E901 hex 1 hex — — Version

E901 hex 2 hex — — FSoE slave address

E901 hex 3 hex — — Connection ID

E901 hex 4 hex — ✓ Watchdog time

E901 hex 5 hex — — Reserved

E901 hex 6 hex — — Connection type

E901 hex 7 hex — — ComParameterLength

E901 hex 8 hex — — ApplParameterLength

F980 hex 0 hex — — FSoE slave address

Tab. 11: Objets de communication ETG.5001.4 : E000 hex – EFFF hex



STOBER 11 | Annexe
03

/2
02

0 
| 

ID
 4

42
74

5.
03

49

11.2 Informations complémentaires
Les documents indiqués dans le tableau ci-dessous contiennent des informations complémentaires relatives au servo-
variateur.

Les versions actuelles des documents sont disponibles à l’adresse http://www.stoeber.de/fr/download.

Appareil / logiciel Documentation Contenus ID

Servo-variateur SC6 Manuel Structure du système,
caractéristiques techniques,
planification, stockage, montage,
raccordement, mise en service,
fonctionnement, service après-
vente, diagnostic

442791

Servo-variateur SC6 Instructions de mise en service Structure du système,
caractéristiques techniques,
stockage, montage, raccordement,
mise en service

442794

Système modulaire avec SI6 et PS6 Manuel Structure du système,
caractéristiques techniques,
planification, stockage, montage,
raccordement, mise en service,
fonctionnement, service après-
vente, diagnostic

442729

Système modulaire avec SI6 et PS6 Instructions de mise en service Structure du système,
caractéristiques techniques,
stockage, montage, raccordement,
mise en service

442732

Communication EtherCAT – SC6,
SI6

Manuel Montage, installation électrique,
transfert de données, mise en
service, informations
complémentaires

443026

Informations complémentaires et sources sur lesquelles repose la présente documentation ou dont proviennent les
citations :

Beckhoff Automation GmbH & Co. KG (éditeur) : Documentation du système EtherCAT. Version 5.1. Édit. 2016.

Une version de base du logiciel d'automatisation TwinCAT 3 est disponible gratuitement à l'adresse 
https://www.beckhoff.de/default.asp?download/tc3-downloads.htm.

EtherCAT Technology Group (ETG), 2012. ETG.1300 : EtherCAT Indicator and Labeling. ETG.1300 S (R) V1.1.0. Specification.
27/01/2012.

EtherCAT Technology Group (ETG), 2016. ETG.5001 : Modular Device Profile, Part 4: Safety Modules Specification.
ETG.5001.4 S (D) V0.2.1. Specification. 05/08/2016.

EtherCAT Technology Group (ETG), 2016. ETG.6100 : Safety Drive Profile, Part 1: Overview, Scope. ETG.6100.1 S (R) V1.2.0.
Specification. 08/02/2016.

EtherCAT Technology Group (ETG), 2016. ETG.6100 : Safety Drive Profile, Part 2: Generic Safety Drive Profile for adjustable
speed electrical power drive systems that are suitable for use in safety-related applications PDS(SR). ETG.6100.2 S (R) V1.2.0.
Specification. 08/02/2016.

EtherCAT Technology Group (ETG), 2016. ETG.6100 : Safety Drive Profile Part 3: Mapping to Safety-over-EtherCAT.
ETG.6100.3 S (WD) V1.2.0. Specification. 08/02/2016.

http://www.stoeber.de/fr/download
https://www.beckhoff.de/default.asp?download/tc3-downloads.htm
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11.3 Abréviations

Abréviation Signification

µC Microcontrôleur

CRC Cyclic Redundancy Check (fr. : contrôle de redondance cyclique)

CEM Compatibilité Électromagnétique

ESI EtherCAT Slave Information (fr. : description d'un Esclave EtherCAT)

ETG EtherCAT Technology Group

EtherCAT Ethernet for Control Automation Technology

FSoE Fail Safe over EtherCAT

IGBT Insulated Gate Bipolar Transistor (fr. : transistor bipolaire à électrode de grille)

I/O Input/Output (fr. : entrée/sortie)

PDO Process Data Objects (fr. : objets de données process)

PDS(SR) Power Drive System(Safety Related) (fr. : entraînement de puissance à fonction de sécurité
intégrée)

PDU Process Data Units (fr. : unités de données process)

PL Performance Level (fr. : niveau de performance)

MLI Modulation de largeur d’impulsion

PDO de réception Receive PDO (fr. : PDO de réception)

SIL Safety Integrity Level (fr. : niveau d’intégrité de sécurité)

SIL CL Safety Inegrity Level Claim Limit (fr. : limite de revendication du niveau d’intégrité de sécurité)

API Automate programmable industriel

SRECS Safety Related Electrical Control System (fr. : système de commande électr. relatif à la sécurité
d’une machine)

SRP/CS Safety Related Part of a Control System (fr. : pièce relative à la sécurité d’une commande)

SS1 Safe Stop 1 (fr. : arrêt fiable 1)

SS1-t Save Stop 1-time (fr. : arrêt fiable 1, contrôlé par minuterie)

STO Safe Torque Off (fr. : absence sûre de couple)

TwinCAT The Windows Control and Automation Technology

PDO d'émission Transmit PDO (fr. : PDO d'émission)
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12 Contact

12.1 Conseil, service après-vente, adresse
Nous nous ferons un plaisir de vous aider !

Vous trouverez sur notre site Web de nombreux services et informations concernant nos produits :
http://www.stoeber.de/fr/service

Pour tout renseignement complémentaire ou des informations personnalisées, n'hésitez pas à contacter notre service de
conseil et de support :
http://www.stoeber.de/fr/support

Vous avez besoin de notre First Level Support : 
Tél +49 7231 582-3060 
applications@stoeber.de

Vous avez besoin d'un appareil de rechange :
Tél +49 7231 582-1128
replace@stoeber.de

Assistance téléphonique 24 heures sur 24 : 
Tél +49 7231 582-3000

Notre adresse : 
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Straße 12
75177 Pforzheim, Allemagne

12.2 Votre avis nous intéresse
Nous avons rédigé la présente documentation avec le plus grand soin afin de vous aider à étendre et perfectionner, de
manière profitable et efficiente, vos connaissances spécifiques à notre produit.

Vos suggestions, avis, souhaits et critiques constructives nous aident à garantir et perfectionner la qualité de notre
documentation.
Si vous désirez nous contacter pour une des raisons susmentionnées, n'hésitez pas à nous écrire à l'adresse :
documentation@stoeber.de

Nous vous remercions pour votre intérêt.
L'équipe de rédaction STOBER

http://www.stoeber.de/fr/service
http://www.stoeber.de/fr/support
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12.3 À l'écoute de nos clients dans le monde entier
Nous vous assistons avec compétence et disponibilité et intervenons dans plus de 40 pays :

STOBER AUSTRIA
www.stoeber.at
Tél. +43 7613 7600-0
sales@stoeber.at

STOBER SOUTH EAST ASIA
www.stober.sg
sales@stober.sg

STOBER CHINA 
www.stoeber.cn 
Tél. +86 512 5320 8850
sales@stoeber.cn

STOBER SWITZERLAND 
www.stoeber.ch 
Tél. +41 56 496 96 50 
sales@stoeber.ch

STOBER FRANCE 
www.stober.fr 
Tél. +33 4 78.98.91.80 
sales@stober.fr

STOBER TAIWAN 
www.stober.tw 
Tél. +886 4 2358 6089 
sales@stober.tw

STOBER ITALY 
www.stober.it 
Tél. +39 02 93909570 
sales@stober.it

STOBER TURKEY 
www.stober.com 
Tél. +90 212 338 8014 
sales-turkey@stober.com

STOBER JAPAN 
www.stober.co.jp 
Tél. +81 3 5395 678 8 
sales@stober.co.jp

STOBER UNITED KINGDOM 
www.stober.co.uk 
Tél. +44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
Tél. +1 606 759 5090 
sales@stober.com



STOBER Glossaire
03

/2
02

0 
| 

ID
 4

42
74

5.
03

53

Glossaire

Adresse FSoE

Chaque Esclave FSoE possède une adresse qui l'identifie de manière univoque dans le réseau FSoE. L'adresse est
généralement réglée directement sur l'appareil, par exemple via un interrupteur DIP. Dans un système FSoE il est
possible de distinguer au maximum 65 534 (16 bits, adresse 0 non autorisée) participants par leurs adresses.

Catégorie

Conformément à la norme DIN EN ISO 13849-1 : classification des pièces relatives à la sécurité en ce qui concerne leur
résistance aux défaillances et leur comportement consécutif à une éventuelle défaillance. Une catégorie est atteinte en
fonction de la structure et de l’agencement des pièces, de leur détection des défaillances et / ou de leur fiabilité.
Désignations possibles des catégories, cela signifie que les classifications sont B, 1, 2, 3, 4.

Diffusion IPv4-Limited

Type de diffusion dans un réseau avec IPv4 (Internet Protocol Version 4). L'adresse IP 255.255.255.255 est indiquée
comme destination. Le contenu de la diffusion n'est pas détourné par un routeur et est par conséquent limité au
propre réseau local.

Domaine de diffusion

Réseau logique de périphériques réseau dans un réseau local qui atteint tous les participants par la diffusion.

Fail Safe over EtherCAT (FSoE)

Protocole pour la transmission de données de sécurité via EtherCAT, en utilisant un Maître FSoE et un nombre indéfini
d'Esclaves FSoE (c'est-à-dire les appareils dotés d'une interface Safety over EtherCAT). Ce protocole permet la
réalisation de la sécurité fonctionnelle via EtherCAT. Le FSoE et son implémentation sont certifiés TÜV et sont
conformes aux exigences SIL 3 conformément à la norme CEI 61508.

Fichier ESI

Fichier de description de l'appareil pour les Esclaves EtherCAT. Conformément à ETG.2000 : fichier XML qui contient
toutes les données pertinentes d'un participant EtherCAT dans le système EtherCAT, comme par exemple l'identité du
fabricant, de code produit, la version ou le numéro de production. Le Maître EtherCAT a besoin de ce fichier pour la
configuration du système EtherCAT.

Insulated Gate Bipolar Transistor (IGBT)

Transistor bipolaire à grille isolée. Élément de construction à semi-conducteurs et à quatre couches, qui est piloté via
une passerelle et combine les avantages des transistors bipolaires et des transistors à effet de champ. On emploie
principalement les IGBT dans le domaine de l’électronique de puissance.

PDO

Objets de communication dans un réseau CANopen ou EtherCAT qui transmettent les données telles que les valeurs de
consigne et les valeurs réelles, les instructions de commande ou les informations d'état en fonction d'un événement ou
d'une destination, de manière cyclique ou sur requête en temps réel. En général, les PDO sont échangés avec priorité
via le canal de données process. En fonction de la couche des différents participants, on distingue entre les PDO de
réception (RxPDO) et les PDO d'émission (TxPDO).
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Performance Level (PL)

En vertu de la norme DIN EN 13849-1, dimension de fiabilité d'une fonction de sécurité ou d'un module. Le niveau de
performance est mesuré à l’aide d’une échelle de a à e (du PL le plus faible au PL le plus élevé). Plus le PL est élevé, plus
la fonction considérée est sûre et fiable.

Principe Black-Channel

Technique permettant la transmission de données sûres via des câbles de réseau ou de bus peu sûrs. Les composants
Safety peuvent transmettre les données de sécurité indépendamment du matériel au moyen d'un protocole sûr qui
tunnellise le canal réseau sous-jacent. Les erreurs de transmission possibles sont mentionnées dans les normes CEI
61784-3 et CEI 61508.

Probabilité de défaillance dangereuse par heure (PFHD)

Conformément aux normes DIN EN 61508/DIN EN 62061 : probabilité moyenne d'une défaillance dangereuse d’un
appareil par heure. Constitue, avec PFH, l’une des bases de calcul fondamentales de la fiabilité de la fonction de
sécurité d’appareils, la classification SIL.

Safe Stop 1 (SS1)

Conformément à la norme DIN EN 61800-5-2 : procédé pour l’immobilisation d’un PDS(SR). En ce qui concerne la
fonction de sécurité SS1, le PDS(SR) exécute l’une des fonctions suivantes : a) Déclencher et contrôler l'importance du
ralentissement moteur dans les limites définies et déclenchement de la fonction STO si la vitesse de rotation du
moteur est inférieure à une valeur limite définie (SS1-d), ou b) Déclencher et superviser l'importance du ralentissement
moteur dans les limites définies et déclenchement de la fonction STO si la vitesse de rotation du moteur est inférieure
à une valeur limite définie (SS1-r), ou c) Déclencher le ralentissement moteur et, après une temporisation spécifique à
l'application, déclenchement de la fonction STO (SS1-t). SS1(-t) correspond dans ce cas à l’immobilisation contrôlée par
minuterie selon la norme CEI 60204-1, catégorie d’arrêt 1(-t).

Safe Torque Off (STO)

Conformément à la norme DIN EN 61800-5-2 : procédé pour l’immobilisation d’un PDS(SR). Avec la fonction de sécurité
STO, le moteur n’est pas alimenté en énergie pouvant provoquer une rotation (ou un mouvement avec un moteur
linéaire). Le PDS(SR) ne fournit pas d’énergie au moteur pouvant générer un couple (ou une force avec un moteur
linéaire). La fonction STO est la fonction de sécurité la plus fondamentale intégrée dans l’entraînement. Elle
correspond à la mise à l‘arrêt non contrôlée conformément à la norme DIN EN 60204-1, catégorie d’arrêt 0.

Safety Integrity Level (SIL)

Conformément à la norme DIN EN 61800-5-2 : probabilité de défaillance d’une fonction de sécurité. La classification SIL
comporte quatre niveaux, de 1 à 4 (du niveau le plus faible au plus élevé). Le SIL garantit une évaluation précise des
systèmes et sous-systèmes. Plus le SIL est élevé, plus la fonction considérée est sûre et fiable.

Safety Integrity Level Claim Limit (SIL CL)

SIL maximal pouvant être sollicité – par rapport aux limitations structurelles et à l’intégrité systématique de la sécurité
d’un sous-système SRECS. Un niveau SIL CL dépend de la tolérance aux anomalies du matériel (HFT) et de la proportion
de défaillance en sécurité des sous-systèmes (SFF).
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Temps d’arrêt STO

Intervalle de temps à partir de l’activation de la fonction de sécurité jusqu’à la mise hors tension sécurisée du bloc de
puissance du servo-variateur.

Temps de mission (TM)

Conformément à la norme DIN EN 61800-5-2 : temps de fonctionnement cumulé défini du PDS(SR) pendant sa durée
de vie totale.

Temps de réaction worst case

Intervalle de temps maximal nécessaire pour couper l'actionneur en cas d'erreur.
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